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Opening Interwrite Workspace 8.5 

1. Double-click on the Interwrite Starter icon on your desktop. 
2. Click on the eInstruction Tools icon at the bottom right corner of your desktop 

and select Workspace... 
 

 

3. The (default) Intermediate toolbar will appear on your desktop (in vertical view).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Click on the Create Blank Page icon (about the 14th icon from the top of the 
toolbar) to create a new page.  

 
 
 
 
 
 

#4 

#3 

#1 

#2 



 
 

Adapted from the Interwrite Workspace Tutorials and C:\Program Files\eInstruction\Interwrite Workspace\Help\wsENU\workspace.htm  5 
 

Interwrite Workspace Toolbar Overview 
(Default Intermediate) 

 
 

Icon 
 
 

 

Tool Name 
 

Description 
 

Application 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Minimize Toolbar 
 
Workspace Menu 
 
Mouse Mode 
 
Lesson Mode 
 
Selection 
 
Pen 
 
Highlighter 
 
Eraser 
 
Shapes 
 
Line 
 
Text 
 
Undo 
 
Clear 
 
Create Blank Page 
 
Create Grid Page 
 
Gallery 
 
Previous Page 
 
Next Page 
 
Page Sorter 
 
Save 
 
Toolbox 
 
Student Response 
System Functions 
 
Exit 

 

Shows or hides the main toolbar 
 
Offers quick access to the options most often used 
 
Switches modes and displays the desktop 
 
Is the primary operational mode 
 
Selects the desired target, text, or image 
 
Creates freehand annotations 
 
Emphasizes important passages in text 
 
Removes selected information 
 
Draws a varitey of geometric shapes 
 
Draws different types of line styles,  width, & colors 
 
Adds a text box to the page 
 
Reverses the last or series of operations/entries 
 
Removes text and images on the current page 
 
Adds a new page to the presentation file 
 
Adds a new grid page to the workspace file 
 
Contains teaching resources, images, and simulations 
 
Selects the previous page 
 
Selects the next page 
 
Displays thumbnail images of all pages within the file 
 
Saves the currently open file to the selected directory  
 
Displays tools not available on the main toolbar 
 
Displays when a student response system (clicker) is 
installed 
 
Exits Interwrite Workspace 

 
 
 
 
Opens items on the desktop 
 
Uses mouse & annotation tools 
 
Grabs and manipulates items 
 
Writes or draws on the page 
 
Highlights anything 
 
Clears  selected text/objects 
 
Creates shapes        
 
Draws lines on the page 
 
Adds  typed-text   
 
Undoes  the latest  operation 
 
Deletes  selected object(s) 
 
Creates a new page 
 
Creates a new grid page 
 
Inserts selected images/SIMS 
 
Goes  to the previous page 
 
Goes  to the next page 
 
Duplicates, deletes, merges, 
views, renames, exports pages 
 
 
Contains seldomly used tools 
 
Creates, poses, and edits 
questions to use with clickers 
 
Closes Interwirte Workspace 
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Quick Overview: Click on the Workspace Menu icon and select the following:      
Preferences, Customize Toolbar, Current, and Advanced.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Annotate Over Desktop 

Gallery (Exam View, Special Needs, Video & Lessons) 

*New Tool or Icon 
Please note that your toolbar fades to be less obstructive 

Minimize Toolbar 

Mouse Mode 

Selection 

Freehand Text 
Multicolor Pen 

Curtain 

Highlighter 

Line 

Fill 

Text 

Record and Playback 

Previous Page 

Clear 

Create Grid page 

Triangle 

Ruler 

Exit 

Toolbox 

Page Sorter 

Link History 

Workspace Menu 

Lesson Mode 

Office Mode 

Shapes 

Pen 

Freehand Shape 

Picture Pen (Add Picture) 

Stamper (Add picture) 

Eraser 

Undo 

Compass 

Capture (Freeform) 

Protractor 

New Page Setup (Create Gradient page) 

Next Page 

Save 

Student Response System Functions 

Import from Devices 

Create Blank Page 
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More on Customizing    Your Toolbar 
 
Use this Preferences selection to organize, add, and remove tools on your Toolbar and 
in your Toolbox. The Current pane lists the tools in the selected scheme. The tools are 
listed as they would display in the tool, preferences, and the right-click toolbar.  
 
The table below describes the toolbar scheme options. 
 

Toolbar Scheme Description 

BasicBasicBasicBasic    Basic set of commonly used tools 

IntermediateIntermediateIntermediateIntermediate    Default setting. Includes the most commonly used pens and set up 
options on the toolbar 

AdvancedAdvancedAdvancedAdvanced    Includes more graphically oriented options on the toolbar 

Adding Tools 
Complete the following steps to add a tool from the Main Toolbar, the Toolbox, or the 
Right-Click Toolbar. 
 

1. Locate the tool you want to add in the Available Tools field. 
 

 
 

2. Select the tool with the mouse or Interwrite Pen. 
 

3. Drag the tool to the location you require. Repeat until you are finish adding or 
moving the tools you need. Click OK. The tools are saved in their new location. 
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Removing Tools from a Toolbar 

 
Complete the following steps to remove a tool from the Main Toolbar, the Toolbox, or 
the Right-Click Toolbar. 
 
1. Select the tool to be removed with the mouse or Interwrite Pen.     
 

 
 
2. Drag the tool away from the box where it is displayed. Repeat until you are finish  

removing the tools. 
 

 
  
3. Click the Remove All button if you want to delete all the tools from the Current     

Tools list. 
 
4. Click OK. The tools are removed from the Toolbar, Toolbox or right-Click  

Toolbar. 
 

 
 
Custom Schemes 
After moving tools to the desired locations, you can save it to a custom scheme.  
 
Saving a Custom Scheme 
Click Save Scheme. The Enter Name window opens. 
Type the name of the new scheme and click OK. 
The new scheme is added to the Scheme drop-down list.  
 
Deleting a Custom Scheme 
Select the custom scheme to be deleted from the Scheme drop-down list. Click Delete 
Scheme. The custom scheme is deleted. 
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Calibrating the Board 
 
There are three ways to calibrate your Interactive board. Calibrate your 
board when you wish to align the position of the pen relative to the 
projected image on the surface of the Interwrite board. 
 

1. Click on the “Calibrate” hot spot on the right side of your 
Interactive board and tap on each of the nine bull’s eye target . 
(See Figure 1) 

2.  

3. Double-click on the eInstruction Tools icon . Select 

eInstruction Device Manager…, click on the Calibrate icon , 
and use the Interwrite pen to tap each red calibration point as it 
becomes visible on the blue screen. 

 
 
 
 
 
 
 
 
 
 

4. Click on the Workspace Menu . Select Device Manager… Click on the 

Calibrate icon  or select Options and Calibrate... 

        
 
Recalibration is required when either the Interwrite Board or the projector has been move 

Opening an Existing Document 

 

#1 

#2 

#3 

Figure 1 

http://www.convergentsolution.us/siteadmin/popups/images/Interwrite%20learning%20Logo_tag.jpg
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If this does not work… 

5. Once the Workspace is opened, either 
6. Right click on the menu toolbar 

OR 

7. Click on the Workspace menu (3rd icon on the menu bar) 
8. Click on File 

 

9. Then click on Open and navigate to 
the folder that has your Interwrite 
file(s) 
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Personalizing Your Picture Gallery 
 
You can add your own images and backgrounds to the Gallery.  Your pictures will be 
immediately available from the main toolbar.  Your frequently used pictures, graphs, 
charts, tables and organizers should be considered for placement in the Gallery.  
Interwrite supports the following file formats:  JPG, JPEG, BMP, GIF, DIB, RLE, EMF, 
WMF, TIFF, and PNG. Compressed pictures work best.   
 

• Open the Gallery from the Interwrite Workspace toolbar.   

• Select a Category. This is where you want the picture to be 
stored.   

o Note: You can add a new category.  Click on the New 
Category button. Type the name of the new category and 
hit the enter key or right-clicking an existing category. 

• Select Add Files to Category button.  The Add File(s) to Gallery 
window will open.   

• Find and select the picture you would like to add to the Gallery. 

• Click on Open to add the picture to the category. 

• Your image will now be a part of the Interwrite Workspace Gallery 
and can be accessed directly from your toolbar. 

 

To use a picture as a background: 

• Right click the picture that you would 
like to use as a background. 

• Select Properties. 

• Click the box Use picture as 
background.   

• Click on OK to close the window. The 
right corner of the image will now be 
turned down to indicate that it is a 
background picture.  

 

You can add an image or Workspace Page to the Gallery.  Click on the Add to Gallery 
icon on the bottom of the Workspace toolbar.  Select Add Current Page to Gallery to 
add the entire page or select Add Selection to Gallery to add a selected image. 
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Using eInstruction Device Manager 
 
Device Manager 
To open the Device Manager main window, select the eInstruction Tools  
icon on the far right bottom of your computer and select eInstruction Device 
Manager. 
 
The Device Manager main window allows you to connect devices, view 
properties, lock or unlock pads, identify connected devices, and perform 
other management functions. 
 

 
 

The following menu options are available from this window. 
 
 

File Menu 
• Setting Preferences 
• Exiting Device Manager   
 
Options Menu 
• Add Bluetooth 
• Discover 
• Lock All Pads 
• Connect 
• Remove Device     
• Beep 
• Calibrate 
• Set Presenter 
• Set Autoconnect 
• Properties 
 
Help Menu 
• Setting Logging Options 
• Viewing the About Window    
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Using Device Manager Icons 

 

 
Add 
Bluetooth 

Connect or 
Disconnect 
Device 

Remove 
Device 

Beep Calibrate  
Board 

Lock or 
Unlock 
Device 

Sector 
Deselect 
Device 

Automated 
Device 

Properties 

 

Icon Name Used To 

 

  Add 
Bluetooth 

Locate and connect Bluetooth devices to the Workspace software. 

 

Connect or 
Disconnect 
Device 
 

Disconnect the device or devices from communicating with Workspace. 
The icon changes depending on which device is selected. 

 

Remove 
Device 

 Removes device from the Device Manager. 

 

Beep Identify a specific Interwrite Device listed but not given a unique name. 
Select a device in the Devices list window. Click Beep to make the device 
beep.  

 

Calibrate 
Board 

Align the Interwrite Pen position relative to the projected image on the 
Interwrite Board's surface. Use the Interwrite Pen to tap each white 
calibration point as it appears on the blue screen.  
Recalibration is required when either the Interwrite Board or the projector 
has been moved.  
 

 

Lock or 
Unlock 
Device 
 

Prevents all connected devices from inputting to the current session. 
Locked Pads remain connected unless they are powered off. This tool is a 
toggle. As the Unlock Pads tool, it can be used to activate, or unlock, the 
locked Pads.  

 

Select or 
Deselect 
Presenter 
 

Allows for a specific device to control the interaction of Workspace and has 
control over the other connected Interwrite Devices in a session. Select a 
device in the Devices list window. Click Select Presenter to activate the 
device.  

 

Autoconnect 
Device 

Connects pre-selected devices when Device Manager is activated.  Any 
device that does not connect after three attempts must be manually 
connected using the Connect button. Select the checkbox next to each 
Bluetooth-enabled device to connect automatically.  
 

 

Properties Opens the Properties window for the selected Interwrite Device.  
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File Menu 

• Setting Preferences and Exiting Device Manager 
 
 
 
      

 

The Preferences window determines the default language for Workspace, as well as 
Bluetooth connection defaults and novice settings.  

 

 

 

 

 

 

 

Use the table to determine your preferences. 

Field Action 

Language Use the drop-down list box to select the language you need Workspace to 
display.  

Clear 
Bluetooth 
Devices List 

Selecting this checkbox clears all Bluetooth connected devices after each 
Workspace session. When Workspace is reopened, you will have to 
rediscover and reconnect all devices. 

Show First 
Look 
window at 
Startup 

If selected, displays a window that helps novice Workspace users with 
connecting devices to the Device Manager. 

 
Exiting Device Manager 
 

• Right-click the eInstruction Device Manager icon. The Device Manager Menu opens.  
Select Exit. The Device Manager application closes and removes the Device Manager 
icon from the Task Bar. To Exit Device Manager from the Main Device Manager Menu 
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• While in the Device Manager Main window, select File>Exit. 
The Device Manager application closes and removes the Device Manager icon from the 
Task Bar. 

 
Options Menu   
 
• Add Bluetooth, Discover, Lock All Pads, Connect, Remove 

Device, Beep, Calibrate, Set Presenter, Set Autoconnect, and 
Properties 
 

Connecting Devices to Workspace 
1. Go to Options>Add Bluetooth Device or click Add. 

The Add Bluetooth Device window opens. 
 

 
2. Type the last four characters of the device to connect. 

OR Click Scan for Devices. 
 
Device Manager scans for Bluetooth-enabled devices. Once items are located, 
they are displayed in the drop-down list box, and the scan is finished. 
 

 
3. Select the device needed from the drop-down list. 

 

4. Click Connect. The Device Manager window displays and attempts to connect 
to the Bluetooth-enabled device. The Bluetooth-enabled device connects, and 
displays in the main window. All available menu options become active. The 
device now can be used in conjunction with Interwrite Workspace. 
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Using Device Manager General Properties 

 
 The following tabs access the SoftKey Preferences for the selected Interwrite Device: 
SoftKeys, Mapping, Double Click, and Log. 

 

 The following table describes the features of the General Properties page: 

Field Description 

Name 

Name of Pad, Board, or Panel. The default name is the last four 
characters of the Bluetooth address.  

Type in the field to create a unique name for the device. 

Manufacturer Maker of hardware device currently being used. 

Model Type of device being used. 

Interface The method the device is using to communicate with Workspace.  

Address Full Bluetooth address of device. 

Physical Size 
Actual size of device. While panels and pads are the same size, 
Boards can vary in size. 

Firmware The version of computer program that is embedded in the 
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hardware device. 

Inactivity Time 
The amount of time set before a device shuts itself off 
automatically. Slide the cursor to adjust the time. 

Battery Status Amount of power left before the device requires charging. 
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Using Page Sorter 
Sorting, saving, and deleting Interwrite files and pages 

 
Use the Page Sorter to view thumbnails of the pages in a file. To open, click on the 
Page Sorter icon on the Toolbar.  The thumbnail list will appear on the right.   
 
 
 
 To rearrange a presentation, click and drag a page to a different 
location within the presentation.  A black cursor and pages icon will sit 
in the space where the page will be moved.   
 
 
 
 
To delete, click on the page or pages; a gray border will appear 
around the pages.  Click the Trash Can on the top bar, or press 
“delete” on your keyboard.  A warning will appear with the page 
numbers of all pages selected.  You can not undo this option.   
 
 
 
 
 
 
 
 
 
 

 
To Save:   
Pull down the Workspace Menu from the Interwrite Toolbar,  
go to File, then Save.  Other file options are available. 
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transparency options 

 

Using the Pen Tool 
 
The pen allows you to write in many colors, line widths and forms as well as 
different levels of transparency. 

 
 
 
 
 
 

 
 
 
 
 

 
Option Function 
Line color  Selection of pen color 
Color palette Selection of alternate colors on the spectrum 
Line width  Selection of line width  
Line transparency  Selection of transparency of lines drawn with 

the pen tool 
Line ends Selection of lines, line segments and arrows 
Dash styles Selection of filled or dashed line options 
Preview Allows viewer to see all selected options 
 
 
 
 
 

color options 

color palette 
line 

 ends 

line 
width 

options 

transparency 
options 

preview dash styles 

line width line ends dash styles 
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Using the Shapes Tool 
Draw shapes with this tool. Click on the Shapes button in the middle of the 
Properties Bar and select a shape from the menu.  The settings on the left side 
of the Properties Bar affect the line attributes of the shape. The settings on the 
right side affect the fill attributes of the shape.  The currently selected shape 
and its line and fill attributes are reflected on the Shapes button.  

 
 
 
 

 
 

 
 
 

 
 

 
 

Option Function 
Line color  Selection of shape outer line color 
Line color palette Selection of alternate colors on the spectrum 
Line width  Selection of line width options 
Line types  Selection of filled, dashed, or dotted lines 
Line transparency  Selection of transparency of outer line of shape 

Shape Selection  Selection of thirteen different shapes 
Shape fill  Selection of shape fill color 
Shape fill color palette Selection of alternate colors on the spectrum for shape fill 
Shape fill transparency 
options 

Selection of transparency of shape fill 

 
 

line color options 

line color 
 palette 

shape options 

line width 
options 

line transparency 
options 

line width 
options 

fill color options 

shape fill 

fill color palette fill 
transparency 
options 

line types 

line types 
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Using the Line Tool 

 
Use the Line tool to draw lines on the page in the Annotation Window.  The 
settings options for the Line tool are found on the Properties bar. The selected 
tool settings are displayed in the preview window. Click on a feature on the 
Properties bar to learn more about it. 

 
 
 
 
 
 

 
 
 

 
 
 
 
 
Option Function 
Line color  Selection of pen color 
Color palette Selection of alternate colors on the spectrum 
Line width Selection of line width 
Line transparency  Selection  of transparency of lines drawn with the pen 

tool 

Line ends Selection of lines, line segments and arrows 
Dash styles Selection of filed or dashed line options 
Preview Allows user to view all selected options 
 

preview 
 line 
color 

color 
palette 

  line 
width 

      line 
transparency 

line 
ends 

dash 
styles 

line 
width 

line 
ends 

dash 
styles 
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Using the Picture Pen 
 
Use the Picture Pen to draw a path of images on a page in the Annotation 
Window.  The Picture Pen is a useful tool for graphs, frames and borders.  It is 
located in the tool box. 

• The currently selected picture is displayed on the left side of the Properties Bar. 
Click on it to access a menu of pictures. 

• Click on the line width property to select a size for the images on the path. 
• You can add a new picture to the picture menu.  Click on the change Picture 

button.  By default, the Program Files/InterWrite Learning/InterWrite 
Workspace/stamps directory is opened. You can select a picture from this 
directory, or you can navigate to another location.  Images used for the Picture 
Pen tool must be in a BMP, GIF, JPEG, TIFF or PNG format.  The new picture 
will replace the currently selected picture on the picture menu. 

• You can also change the background color of the selected  
• picture.   

 
 
 
 
 
 
 
 
 
 
 

 
 

Option Function 

Select picture Choose different pictures 

Line width Expand or minimize lines 

Add a picture Use your own pictures 

Select line transparency Make lines more or less visible 

 

    
    

Selected 
picture 

Line width Add a picture 

Select a 
transparency 

the line 
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undo 

redo 

   cut 

copy 

paste 

select all 

order  rotate 

group 

ungroup 

export 

move to background 

add to gallery 

Using the Selection Tool 
 

Use the Selection tool to select entities – text, shapes, images, etc. – on the 
current page. Selected entities can be modified.  Click on an entity to select it.  
Select multiple entities by clicking and dragging the Selection too boundary 

around the entities.  The Selection tool is an editing tool and can be accessed from the 
Workspace toolbar.  
 
The selection options listed above can be accessed from the Selection tool options on 
the bottom of the Workspace as shown below. 
 
 
 
 
 
 
 
 
 

Option Function 
Undo Removes the last action completed 
Redo Completes the last action removed 
Cut Removes selection from page 
Copy Copies selection from page 
Paste Adds previously copied or cut selection to page 
Select All Allows selection of all entities on page 
Order Allows selected entities to be placed at different locations 

on the page 
Rotate Allows for the rotation of the selected entity 
Group Allows for multiple entities to be grouped as a single item 
Ungroup Allows for items to be permanently placed in the page 

background 
Move to background Allows for items to be permanently placed in the page 

background 
Export  Allows for selected entities to be exported as image files 
Add Files to Gallery Allows for selected entities to be added to the InterWrite 

Gallery as images 
Fill Changes page color or color of selected area 
Lock Object Moves object to background temporarily 
Copier Copies selected area; deselect to stop making copies 
Link Select area may be linked to internet, other pages, video 
 

 
 

Fill Lock Object Links Copier 
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Using Presentation Tools: Curtain and Spotlight 
 
The Curtain tool is used to hide the pages of a Workspace presentation or to hide the 
desktop screen if you are in Mouse Mode. Handles on all four sides of the Curtain make 
it possible to reveal a section or all of a display in the Workspace, while still covering 
some of the display.   
 

1. The Curtain can be opened from the Toolbox or the Windows operating 
toolbar on the bottom of your monitor. 

2. The default color is black.  Click on the Curtain Color button to change the 
curtain’s color. 

3. Click and drage the Transparency slider to the left to add transparency. 
 
 
 

Use the Spotlight tool to draw attention to an area on the screen.  It can be used in 
Mouse Mode or Lesson Mode.   

1. Select the Spotlight tool from the Toolbox or the Windows operating toolbar 
on the bottom of your monitor.   

2. A circle appears in the center of a black curtain.  This circle is a transparent 
opening that reveals what is directly beneath it on the screen. 

3. Click and drag the cursor to move the spotlight around the screen. 

 
The default circle shape, the screen color, and the transparency of the screen can be 
changed using the Spotlight Preferences toolbar - bottom, middle of screen. 

 

 

 
 
 
 
 

 
 
 
 
 
 

Resizing Frame Spotlight Preferences Close Spotlight 
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Using the Text Tool 
 
Use the Text tool to add typed text on the pages in your presentation file.   
 

• Select the Text tool from the toolbar. 
• Change font properties before you begin typing. The font and attributes you 

selected will display in the preview window. 
• Click where you want the Text Window to display and begin typing. 
• When you have finished typing, select the Selection tool.  The Text Window 

closes and the text is placed on the page. 
 

 
 
 
 
 
 

 
 
 

 
Option Function 
Text color Selection of text color 
Color palette Selection of alternate colors on the spectrum 
Font type Selection of font type options 
Font size Selection of font size options 
Other text  Selection of bold, italics, and underline for text 
Text linking  Selection text links to documents, media files, and web pages  
 
 
 

color options 

color 
palette 

font size 

preview 

bold 

font 
type 

italics 

underline 

Using the “Split Sentence 
into Words” tool, any 
sentence typed with the 
text tool will be split into 
words and each individual 
word can be moved or 
annotated. 

Using the “Clone Text” 
tool, any text can be 
duplicated in the 
InterWrite workspace. 
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Using the Fill Tool 
 

Another option for changing the background color of your page is to 
use the Fill Tool.  This tool can also be used to change the color of each 
individual page or an object such as a closed shape or graphic you 
have drawn. 

 
Proceed to the Toolbox and select Fill. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the color selection bar or the palette to choose your color.  A paint bucket 
will appear on the screen.  Click and the page will turn to the color you 
selected.  You will need to do this for each individual page.  You can do the 
same for objects. 

Selected color 
Color palette 

Default 
color choices 
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Moving Images to Background 

 
Interwrite has several Background Image pages that may be selected from the Image 
Gallery:  Toolbox.  Image Gallery.   Or, Workspace Menu, Tools, Image Gallery. 
 
 
 
The Image Gallery includes graph “paper” background, 
multiplication tables, music “paper” and a chess board, 
among other applications.  Select and click apply.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Any image can be set to background.  On your Interwrite page, select the image to be 
moved to background.  On the bottom toolbar, select the Move to Background icon.  A 
question will appear.  This action can not be undone, but it can be redone. 
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Using the Capture Tool 

To capture is to make a snapshot of the full screen, the window or a selected 
part of the screen.  Text, illustrations and pictures can be captured from the 
Internet and from pages within the Workspace document.  This invaluable tool is 
used often.    

The Capture Tool is in the Workspace toolbox; the icon is a camera. 
 
 
 
 
 
 
 
 
 
 
 
Find the image or selection to capture.  To capture a section of a page, select Partial or 
Freeform.  To capture the screen, click Window or Screen.  Check the Place capture in 
new page box if you want the image to be placed on a new Workspace page.  If the 
page you want is already open, uncheck the box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Screen includes all 
content within frames 
and toolbars 
 Window is 

content below 
the Internet 

toolbar. 

Partial - Allows 
a selected area 
within a 
rectangular 
form. 
 
Freeform- 
allows selected 
area to be 
“roped”.   
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You can capture or crop areas within Interwrite.  When capturing in Lesson Mode, three 
selections are available.  Use the Freeform or Partial selections to crop or capture 
sections of the page.   
 

Creating a Blank Page 
 

Use a blank page to start any interactive lesson.  You can set a background color 
for your work.  The default background color is white.   To change the color of 
your page, go to the toolbox and proceed to New Page Setup.  Then click on Blank 
Page Setup… 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Check the box if you want the 
image in a new page. 

1. Toolbox 

2. New Page 
Setup 3.  Blank Page 

Setup 

4.  Click on Change 
Background Color and 
proceed to the palette for 
many color choices.  Click  
OK and then click Apply. 

All future pages will be 
this color for this session.  
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Create Gradient Page 
 

Use this option to configure a gradient background for your 
interactive pages.  You can choose from a two color or four color 
gradient background. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 

10.  

2. New Page 
Setup 

1.  Toolbox 

3.  Gradient Page 
Setup 

4.  Preferences 

5.  Click on the solid color boxes to 
select your color choices.  The colors 
window will open.  Make your selection 
and click OK.  The new color will 
appear on the window.  Then click 
Apply.  
 6. Make the 

choice to 
change the 
current 
background 
or make a 
new page. 
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Adapted from the Interwrite Workspace Tutorials and C:\Program Files\eInstruction\Interwrite Workspace\Help\wsENU\workspace.htm  32 
 

 

Creating a Grid Page 
 

Use this option to configure your grid pages.  You can configure 
lined grip pages, pages with columns, and true grid pages with both 
horizontal and vertical lines.  You need to go to the Toolbox, then 
New Page Setup and then Grid Page Setup….  Preferences will 

allow you to make your choices. 

11.  
 
 
 
 
 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

Preferences Options 
Horizontal Set the amount of space between lines or no lines. 
Vertical Set the amount of space between lines or no lines. 
Center Grid For centered grids on the page. 
Add Title Box For use if you want a title or not. 
Change Line Color Change the color of the lines. 
Line Type/Width Use the drop-down for options. 
Change Background Color Use color choices. 

 
 

 
 
 

2. New Page 
Setup 

1. Toolbox 

3.  Grid Page 
Setup 

4.  Preferences 
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Using the Eraser Tool 
 

The Eraser tool is used to remove part or all of the annotations (text, drawings, 
and highlights) on the current page.  Some entities, such as solid rectangles 
and typed text, cannot be erased.  Those entities must be selected with the 
Selection tool and deleted or cut.   

 
 
 
 
 
You can configure the width of the Eraser tool on the slider tool (shown above). Click on 
t he Eraser width slider to increase or decrease the Eraser width. 
 
You can also erase with the felt disk at the end of the large electronic pen (if that is the 
pen accompanying your whiteboard system).  Another option for that pen is to hold 
down the left button and move the pen tip over the annotation. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

pen eraser 
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Using Exam View 

 
The Exam View Learning Series is a collection of over 9,500 questions that work in 
conjunction with Workspace, CPS, and Response. 
 
To Open ExamView Test Files Within Workspace 
 

1.  Click Open ExamView. 
The Open Exam View File window opens. 

2.  Browse to the ExamView file needed. 
3. Click OK 

The ExamView file loads, the first question loads and displays in the Workspace 
Annotation window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Use the ExamView toolbar to navigate through the ExamView Question file. 
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The ExamView Toolbar 
 
 
 
 
 
 
 
 
The ExamView Toolbar controls the ExamView Question file. The following table 
describes the functions of the Toolbar: 
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Using the Freehand Text 

 
All alphanumeric characters written with this tool are automatically converted into 
typed text using the font displayed in the preview window on the tool’s Properties 
Bar.  Select a different font, change the font size, the font style, and the font 
color from the Properties Bar before you begin writing.  Your selections are 

displayed in the preview window. 
 
 
 
 
 
 
 
 
 
 
 
Special care should be given to how your letters are formed, as the system 
may not recognize broken strokes.  

Preview 
window 

Default  
colors 

 Color 
palette 

Font 
 Size 

Font  
style 

 
The use the stamper to add stamps to the current page in the Annotation Window.  The 
pre-installed stamp selections are displayed on the Stamper Properties Bar. You can 
personalize the Stamper by adding your images to the My Documents/Interwrite 
Workspace/User Bar.  If you add new stamp images to the User Stamps folder while 
Workspace is running, the stamps will not be available for use until you exit Workspace 
and re-open it. 
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Using the Stamper Tool
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Using the Interwrite Workspace Gallery 
 
 

The Gallery contains thousands of images, backgrounds and simulations that 
can be used across the curriculum.  Use the Gallery to find maps, math tools 
and tables, science tools and tables, graphic organizers, and interactive 
games and lessons.  The icon for the Gallery is on the toolbar. 

 
Please Note:  The first time that the Gallery icon is selected all gallery images will load.  
This will take a few minutes and will only happen the first time.  
 
To load the Gallery for the first time: 

1. Select the Gallery icon from the Workspace toolbar.  
 

2. An Interwrite Gallery window will open, along with a message to build the 
gallery database.  Click on Yes to begin loading the Gallery database. 

 
 
 
 
 
 
 
 
 
 
 
 

3. The Build Gallery Preferences window will open.  Select Build to begin 
loading the Gallery. 

 
 
 
 
 
 
 
 
 
 
 
 
 

4. When the Gallery database is built you will see the Interwrite Gallery window 
populated. 
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Finding Images in the Gallery 
 
 
Search the Gallery by subject 
or enter key words to search. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use the selection tool to highlight and grab the Gallery image. Slide the 
image out to a blank Workspace page*.  Resize by grabbing the handle 
on the bottom right hand corner with the selection tool.   
 
 
 
 
 
 
 

 
 
*Gallery icons with turned down upper 
right corners are Background Images 
and will fill the workspace page.   
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Using SIMS 
 
SIMS, which are interactive Flash simulations, are pre-made activities in various areas 
of the curriculum. Use a Sims as a warm-up exercise, to provide additional practice, to 
integrate into a lesson, or to just make learning more fun. Some important teacher tools 
are provided including a protractor, ruler, calculator and spinner.  SIMS activities can be 
accessed through the Gallery. 
 
The SIMS activities are marked with an F symbol.  
Drag the activity out of the Gallery, resize and play using the Selection tool.  SIMS 
activities will work when placed in the background.   
 
The TIMER 
Three timers are available. The Interwrite Timer can be found in the Toolbox.  Drag it to 
the desktop or to a Lesson presentation.  Set it as a timer or stop watch. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The SIMS clocks are timers as well as clocks that keep local time.  You can find these 
timers in the Gallery under Interwrite SIMS, Math.   
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transparency options 

Using the Highlighter Tool 

 
Use the tool to highlight anything on the current page. Select tool attributes 
from the Properties Bar at the bottom of the page.  Click on the properties to 
view a description. 

 
 
 
 
 
 

 
 

 

 
 

 
 
 
 
 
 
 
Option Function 
Highlighter Selection of highlighter color 
Color palette Selection of alternate colors on the spectrum 
Shape options Selection of freehand, rectangular, or round 

shape options 
Line width options Selection of line width 
Line transparency 
options 

Selection of transparency of lines drawn with 
the pen tool 

color options 

color palette 

shape options 

line width 
options 

transparency 
options 

line options 

 shape options 
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Using Layers 
 
Interwrite Workspace pages may be set up as layers.  This will allow for manipulation of 
foreground images without moving all layers to background.   
 
 
 
A Workspace page will offer a Layers application.  This will allow you to organize, list 
and move between pages and objects.  Examples would be using a ruler image over a 
map to measure the scale of miles.   
 
By default, each new Workspace page is organized in a single parent layer.  Create 
new layers to move items into them, or move items from one layer to another at any 
time. 
 
Working with Layers 

• Open a new page within Lesson Mode 
• Add a picture, draw or annotate the page 

• Click Add Layer    
 

     A new layer is added to the page.  Continue to annotate 
and add layers by clicking the Add Layer button.  The active layer is highlighted in black.   
 
To move an object from one layer to another 

• Select the object you want to move to the other layer. 
• Drag the object to the wanted layer.  The plus sign indicates the layer has been 

moved and will be added to the display in the toolbar. 
 
 

 
 

 

 
 
 

        
        
        

 

Layer bar – bottom left, (above lower toolbar) 
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Using Various Modes in Interwrite Workspace 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using Interactive Mode 
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Using Annotate Over Desktop Mode 
 
 
 
 
 
 
 
 
 
 

 
Annotate Over Desktop 

The Annotation Over Desktop tool is used like the Annotation Window, however your 
desktop is underneath and can be accessed for use.  The Annotation Tools, Page 
Tools, or Capture Tools are usable and can be selected. Elements of the desktop can 
be called out and highlighted for interactive use. 

 

Using Annotate Over Desktop 

The following picture displays an example of a web page in Annotate Over Desktop 
mode. You can select any of the Annotation tools to illustrate features of the desktop, 
such as the Pen, Shapes, or Highlighter tool.  

In the example, elements of the page have been highlighted and circled. You can 
continue to another web page, and the annotations will remain, but you do not have to 
exit out of Interactive Mode to advance to another web page, or application within 
your desktop. 

If you would like to manipulate any of the windows or applications on the desktop, 
choose the select tool on the Workspace Toolbar. 
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Using Office Mode



 
 

Adapted from the Interwrite Workspace Tutorials and C:\Program Files\eInstruction\Interwrite Workspace\Help\wsENU\workspace.htm  46 
 

Using Office Mode Tools 
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Using the Multi User Functionality 

 
The Multi User feature allows for two more people to interact with the InterWrite 
products.  With the InterWrite DualBoard, two people can write on the board at 
the same time. 

 
In addition, you can set up multiple InterWrite Mobis and InterWrite Pads to display 
Products.  With the InterWrite DualBoard, two people can write on the board at the 
same time.  This function is backwards compatible with InterWrite Pads.   
 
Setting Up Multi User Functionality in Workspace 
 

1.  While in the Annotation Window, click the Multi User icon in the bottom right 
corner.  The Multi User Page Setup window opens. 

2. If you have not already done so, connect the devices you need to Workspace.  
You can add up to 9 devices. 
 
 

 
 
 
 
 

The connected devices display in the Available Devices Area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Do NOT add the table you need for controlling the 
Main Toobar and the other devices. If you do, the 
only way can maintain control over all the multi-
user devices is form the computer or the mouse. 
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3. Select the Multi User Page Setup you want to use.  Determine if you want to 
use Collaborative or Defined areas. 

4. Select the device and drag it to the area needed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Device will be able to be view within the area displayed within the Multi User Page 
Set Up Window. 
 
 
 
        



 
 

Adapted from the Interwrite Workspace Tutorials and C:\Program Files\eInstruction\Interwrite Workspace\Help\wsENU\workspace.htm  49 
 

        

Using Record and Playback 

Use the Record and Playback tool to record and play interaction with the whiteboard.  
It records sound and screen events and stores then in an AVI file for play in a 
presentation or separately on a media player.  The Record and Playback tool is in the 
Toolbox. 

 

Click on the icon.   

 

 

 

 

 
 

1. The Capture Window opens.  
2. Select Partial or Screen.  Selecting Screen allows for the full page to be 

captured.   
3. Click Stop when the recording is complete.   
4. A Save window will open in the User Recordings file in Interwrite 

Workspace.   Name the recording for ease in identification and retrieval.   

This file can be inserted in a presentation or lesson and annotated and critiqued using 
the tools provided.  It may also be played separately. 

 

 

 

 
 

1. The recorder opens; move this dialogue 
box to an unobtrusive corner  of the 
presentation and click Ready. 
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Using the Student Response Menu 

 
Interwrite Workspace is enabled for Student Response System (SRS) connections, 
allowing for more interactivity between you and your students.  You can create, edit, 
and pose questions during a session and your students will be able to respond using 
the clickers available. 
 
The SRS window displays all the Student Response options that interact with 
Workspace. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
After selecting the Student Response System option, the Student Response System 
window opens. 
 

Selecting an SRS 
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1.  Exit Workspace, and install the SRS needed, following the instructions for that 
product’s installation. 
 

2. Restart Workspace. 
 

3. Go to File>Student Response System. 
The Student Response System window opens.  The installed SRS is active, and 
pres-selected.  If you have more than one, the top one will be selected. 
 

 
 

Locating the SRS Within the Toolbar 
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Using the Compass 
 

The compass allows you to demonstrate how to draw circles, arcs, and measure 
distances within the Annotation Window. 
 

 
 
 
 
 
 
 
You can move, size, and rotate the Compass.  The Compass resizes itself to scale 
within the Annotation window.  The Colored  tip draws the circle or arc within the 
Annotation Window.  The Clear tip remains stationary so the arc or the circle can be 
drawn. 
 
To change the radius of the compass, nove your cursor to the colored tip until the 
compass displays the arrow.  You can then drag that end to the desired radius. 
 
Using the Compass 
 

1.  Click the Compass icon. The Compass opens within the Annotation Window. 
2. Click the top of the Compass to move it around the Annotation Window. 
3. To change the color of the pen tip, select from the Workspace palette at the 

bottom of the Annotation Window.   
4.  Click on the Compass icon to close the Compass and remove it from the 

Annotation Window. 
 
Drawing an Arc with the Compass 

1.  Move your cursor to the colored tip until the Compass displays the arrow. 
 
 
 
 
 
 
 

2.  Click and drag the tip to the desired area.  The tip changes back to the draw 
cursor. 
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3.  Move the cursor to draw the arc. 
 
 
 
 
 
 
 
 
 
 
 
 
Workspace displays the arc within the Annotation Window. 
 
Compass Cursors 
 
The Compass has special cursors indicating how to use it. 
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Using the Protractor 
 
The Protractor allows you to demonstrate how to use angle measurement within 
the Annotation Window.  The Protractor displays the angle in degrees within the 
tool. 

 
 
 
 
 
 
 
 
 
 
 
 
 
You can move, size, and rotate the Protractor.   
 
Opening and Closing the Protractor 
 

1.  Click on the Protractor icon. 
2. Select 180 Degrees or 360 Degree. 

The selected Protractor opens within the Annotation Window. 
3.  Use as needed. Refer to the following table to move the Protractor. 
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4.  Click the Protractor icon to close the Protractor and remove it from the 
Annotation Window. 

Using the Ruler 
 
The ruler allows you to demonstrate how to use measurement between two 
points within the Annotation Window. 

 
 
 
 
You can move, size, and rotate the ruler.  The ruler resizes itself to scale within the 
Annotation window. 
 
Opening and Closing the Ruler 
 

1.  Click the Ruler icon. 
The Ruler opens in the annotation window. 

 
2.  Use as needed. Refer to the following table to move the ruler. Click the Ruler 

icon when finished. 
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Using the Triangle 
The Triangle tool allows you to demonstrate how to measure within the 
Annotation Window. 

 
 
 
 
 
 
 
 
 
 
You can move, size, and rotate the Triangle.  The triangle resizes itself to scale within 
the Annotation Window. 
Opening and Closing the Ruler 
 

1.  Click the Triangle icon. 
2.  Select Left Facing or Right Facing. 

 The selected Triangle opens within the 
 Annotation Window. 

3.  Use as needed.  Refer to the following table to move the Triangle. 
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4.  Click the Triangle icon to close the Triangle and remove it from the Annotation 
Window.
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Interactive Whiteboard Troubleshooting Checklist 
 

 
 

_____ 

Does the pen have a working ‘AAA’ battery? Or has pen been recharged 
in the charger? 
    

 
 
 

_____ 

 
Is the battery polarity correct, with the positive (+) and negative (-) ends 
of the battery inserted into the appropriate ends of the battery 
compartment? 

     Eraser   
     Positive End (+)  
     Negative End (-) 

 
 
 
 

_____ 

Are the two ends of the pen connected correctly?  
Note: Please be careful when connecting the two ends of the pen, as the 
small electronic pins are bendable and can be permanently damaged. 

 
 
 
 

_____ 

Is the battery charged? If you disconnect the two ends of the pen and 
reconnect them, do you see a series of four flashing lights on the LED 
(indicating that the battery has a charge)? 

LED light 
 
 
 

_____ 

Is the whiteboard plugged into a wall socket?  
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_____ 

Is the Bluetooth device on the CPU plugged in completely in the USB port  
and the green LED light is on? 

  
 
 
 

_____ 

Is the Bluetooth device on the whiteboard connected with all plugs 
connected tightly?  

 
 

 
 
 
 

_____ 

Is the power switch on the whiteboard in the “ON” position and the green 
LED light is on and visible? 
 

 
 

 
 
 
 
 

_____ 

Did you correctly start the Interwrite program 
(multicolored square icon) by clicking the icon and 
then going to “Workspace”? 

Power 
switch 

Green LED light 
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_____ 

In the eInstruction Device Manager, have you noticed whether the 
Bluetooth icon is ‘not connected’? 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

_____ 

If the Bluetooth is not connected and 
the name of the whiteboard is not 
visible, did you go to Options and then 
Discover Devices? 
 

 
 
 
 
 
 

_____ 

Have you gone to the Interwrite Device Manager and checked that the 
correct device is selected and 
connected? 
 
 
 
 
 
 
 

 
 
 

 
 

______ 
 
Have you held the pen to the board for 5-10 seconds to get rid of the 
straight lines that appear?  (This problem usually occurs when a board 
has a Bluetooth connection to the computer) 

 
_____ 

 
Have you tried closing and restarting the Interwrite program? 
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_____ Have you tried shutting down and restarting the computer? 
 

 
_____ 

 
If you have checked all of the items on this list, please contact your 
building level technical support (CLT or Computer TA).  You may want to 
place a Helpdesk call.  Please see the Helpdesk instructions. 

  

http://iwl.einstruction.com/support/wstutorials.html#vids
http://iwl.einstruction.com/support/wstutorials.html#vids
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Workspace%20Icon%20Guide.pdf
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Workspace%20Icon%20Guide.pdf
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Workspace%20Icon%20Guide.pdf
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Moving%20My%20Gallery%20Content.pdf
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Moving%20My%20Gallery%20Content.pdf
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Workspace%20Icon%20Guide.pdf
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Using Workspace Online HELP 

 
To access additional help and learn more about the Interwrite Workspace features, click 

on the  Workspace Menu, Help, and Help… 
 

 
 
 

More Online Assistance: 
 
Interwrite Workspace Tutorials: http://iwl.einstruction.com/support/wstutorials.html#vids  
 
Workspace Icon Guide: 
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Works
pace%20Icon%20Guide.pdf  
 
Moving My Gallery Content Into Workspace: 
http://www.einstruction.com/support_downloads/interactive_teaching/workspace/Moving
%20My%20Gallery%20Content.pdf  
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